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Preface

Congratulations for your purchase of Kibron’s Microtrough and FilmwareX 4.2. This
manual will acquaint you with the basic features of the software. Should you have
any questions or other queries related to this product, please contact Kibron by
phone or e-mail:

Contact Information o—
Kibron Inc. Oy.
Malminkaari 23 A
00700 Helsinki
Finland
info@kibron.com

Customer Service and Sales
Tel: +358-9-2811 670
helpdesk@kibron.com
sales@kibron.com

For further details, please visit Kibron homepage at www.kibron.com.
Any inquires may be addressed to info@kibron.com

Document Conventions

This manual uses the following typographic conventions:

Example | Description

This icon alerts the user to the

@ presence of important operating
and maintenance (servicing)

instructions

This icon indicates a warning or

:'! E caution.

Revision History

Revision | Date Changes

A 11/2016 First Release

B 07/2017 Note added on the use of space in chemical names
and abbreviations.

C 11/2018 Manual updated for FilmWareX 4.2 (incl. area

hysteresis, setting up and selecting probes).
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Notes

Chapter 1: Installing the software — ‘Filmware’

It is assumed that you are familiar with standard Windows terminology, such as
‘directory’, *file’” and ‘right hand click’. If you are not, please read your Windows
guide and/or watch the videos. If all else fails, please contact us and we can give
you an on-line demo.

Unpacking:

The software for the trough, called the 'Filmware', can be acquired in different
ways:

1: On the Kibron memory stick
- look for the FilmWareX40directory and run 'setup.exe’
- or double click on: FilmWareX40_inst_rell.exe

2. Via a 'drop box'
This is often distributed as a 'zip' file - just right-hand click on the zip file
and use the Windows extractor to unzip it, and look for
FilmWareX40_inst_rell.exe.

3. Sent as an attachment by e-mail
This is often sent as a 'txt' file, in order to get around your
university/company e-mail security filters.

Just rename the FilmWareX40_inst_rell.txt to:
FilmWareX40_inst_rell.exe

Note: if your PCis set up not to show file extensions, you will need to enable
this in:
'Folder Options' - accessible from 'Tools' in File Explorer.

4. Downloaded from Kibron’s eshop.
-Provided as Filmware40_inst_rell.exe

Installing the Filmware

Left-hand click on:
FilmWareX40_inst_rell.exe

and the Windows installer will take over. It will place the software in
c:\programs(X86)* and will ensure that all files are present. Note that there are
configuration files that are placed in the installation directories as well. Install in a
new directory. To avoid mismatch between new and old files, please do not install
in an existing FilmWare directory.

Running the software for the first time
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The installations package will have placed the FilmWare icon on your desktop.
Please click it - there will be a delay of a few seconds and you may be prompted
by Windows to allow the FilmWare to make changes to the computer. Then a Kibron
logo will appear in the centre of the desktop and shortly afterwards the main screen
will appear.

The following screen will appear, after a short delay... (about 8 seconds).

Shen FilmWareX - X
File View Tools Addons Help
- Mon, 03 Oct 2016 04:18PM | Load Measurement
Offline
Load
Surface Tension o O mN/m
: File Title Date Se
Surface Potential 00 mv
Area 0 mm® < 3
Temperature 00 *C
common controls and status
Run time: Measurement it Buffer:

Measurement Notebook Setup Zero 8 Saveto File

Trough
Measurement settings

— Trough : Pressure (mN/m)

Pressure (mN/m)
o
S
8

-0.06 -0.04 -0.02 000 002 004 006
Time (secs)

418 PM E
10/3/2016 1

A tm EE NG

Establishing communications with the interface

Under normal circumstances the Filmware will automatically connect to the
instrument if it is connected when the software is started. If the 'Offline’ status
message appears on the top left, the first thing we have to do is get the
communications between PC and trough going. We do this by going to the
‘Communications’ window which comes off the ‘Tools’ drop down menu.

Click on ‘Search Device’ to automatically locate the com port - once found the
current port will be displayed (COM3 in the example). If you have other devices
(e.g. dipper) connected to the computer, make sure that the right port is found.
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MicroTrough Setup = MicroTrough Setup H
Communication Communication
Offine ~ = Search Device COM3  +~ | Search Device ]
Found pTrough MTS_3 on COM3
Stepper Stepper
Steps / rey 0 Steps / revy 0
mm / ey 0 mm / ey 0
Temperature Sensor Temperature Sensor
Temp. offset |_U Temp. offset ‘_U
Ok Cancel Ok Cancel

Click on OK to return to the main screen.

If you cannot find the COM port, please check the COM port number and set it to
below 10 in the Windows Device manager, by right clicking the Prolific USB-to-
Serial Comm port, choose Properties, Port settings and Advanced.

Chapter 2: Setting up for an experiment

Selecting trough

Measurernent Motebook Setup
Trough |G2 | Probe |KBN_Wilh Plate ~
a1
Barriers |G1-ribbon ||r|g
Lastir'|itGE'rib|mzIr1 rarras 0936
G4 e
Uszer @
Mode |ye
() Ma XL (®) Semi-Auto

You need to ‘tell’ the software what trough you are using. This sets the correct
length and width for the experiment. To do this select the ‘Setup tab’ on the left of
the screen. Select the trough you are using. If you cannot find the correct trough,
select View -> Troughs, and enter the correct parameters for the trough. Note that
‘Max. Length’ is usually the maximum distance between the barriers — not the
internal length dimension of the trough. The *‘Min Length’ sets the limit for how
close together the barriers can be moved, you may for example, want to increase
this parameter if you have bulky equipment probing the mid-section of the trough.
For some special trough with more complex shape, like the ribbon trough, the ‘Max
Length’, ‘Min Length’ and ‘Width’ do not correspond directly to the physical
dimensions of the trough. The parameters have rather been set so that the area
and compression length is correct.
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The ‘Barrier Width’ is a redundant parameter which does not affect the area
calculated in the software. The ‘Number’ of barriers sets whether both barriers
(symmetric) or one barrier (non-symmetric) is used for compression. This affects
the rate at which the area is changed when the barrier drive is running. The knobs
of the barriers drive should be set accordingly (see below).

,},;m Configure Trough X

Name ‘ p Trough v

Dimensions
Width | 80 | mm
Max Length | 350 ‘ mm
Min Length ‘13 ‘ mm
| et
Barriers
Width | 16.0 | mm

Soen FilmWareX

File View Tools Addons Help

Number (OSingle (@ Double

R Fri, 07 Oct 2016 04:40PM
Lipids setup ..

Define Film

Sineree {5-4 =

Troughs ... {-zsoo.e mv -
’ Area 27999 mm? Cfnse

Temperature - C

Selecting probe

Measurement Motebook Setup

Trough |G2 ~  Probe |KBM_Wilh _Plate

KBM Wilh Plate
Barriers  Sensors  Sampling DyneProbe

Pt10x10
Last initialised | pe, 09 marras 0%

Usr
A new feature in FilmwareX 4.2 is the support of a variety of probes. You can
switch between different probes with the same calibration. The calibration
coefficient is recalculated based using the perimeters of the probes. The Zero
calibration dialog is opened automatically when the probe is changed, when the
probe is changed to remind the user to record a new reference level.
To do this select the ‘Setup tab’ on the left of the screen. Select the trough you
are using. If you cannot find the correct trough, select View -> Probes, and enter
the correct parameters for the probe. Please notice that the 10 mm x 10 mm
platinum Wilhelmy plate cannot be used with our standard sensor.
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Initializing the barrier drive

Before doing any measurements involving the barriers, the drive needs to be
initialized. This procedure teaches the motor drive the datum position, to which all
barrier movements are referred.

First of all, disconnect the barriers from the belt drive - by turning the knobs to the
neutral position, as shown below in a):

Fig. a) Belt drive knobs in neutral position. b) belt drive knobs inwards for normal
compression. c) Belt drive knobs for in coupled mode for moving the barriers in the
same direction.

Measurement Notebook Setup
Trough [ pTrough v

Barriers  Sensors  Sampling

Last initialised | ---.-

(O Semi-Auto

Use this mode if the barriers have been unclamped or after
they have bumped against an obstructions and gone out of

alignment.

Unclamp the barriers,
then click Next

Next > >

Fig. Screenshot of initialization
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Choose ‘Manual’ and click on *Next’. Then follow the instructions on the screen.
Move the barriers (by hand) to the ‘fully open’ position and turn the knobs - both
inwards, as shown in b). This will lock the barriers to the opposite sides of the belt
so that they move in opposite directions. This is appropriate for methods where
control pressure vs. area is required (almost all cases). You may also turn one knob
inwards and leave the other in neutral as shown in d) - set the number of barriers
to 'Single’ as described above.

In the Semi-Auto mode the barriers are moved using the motor. You may use this
mode if the barriers are symmetrically placed with respect to the center of the
trough, i.e. you have initialized the trough previously, or you can use it to carry the
barriers as far out as possible and then adjust them manually to make sure they
are at datum positions.

Calibration of the force sensor

The first time you use the instrument you must calibrate it, and we recommend
that you check the calibration before an experiment and calibrate it if necessary.
The sensor can be calibrated using weight or using a liquid with known surface
tension. The advantage of weight calibration is that a first principles relationship
between the measured force and the surface tension can be shown, and the
reference weight and probe circumference can be confirmed by other methods.
Additionally, the method does not rely on a supply of clean calibration solvent
(water), although this is less of a problem in well-equipped laboratories with high
purity water systems as long as the handling procedures are in place.

The advantage of the calibration using a liquid is that small deviations in the probe
diameter, shape and roughness, which are difficult to physically characterize, are
included in the calibration factor. If high purity water or another solvent with
accurately known surface tension is available, the method tends to give more
accurate results than weight calibration. Under ideal conditions both methods yield
the same results.

To begin calibration choose the ‘Setup’ -> *Calibration tab’ and push the ‘Calibrate’
button to open the calibration dialogue.

Measurement Notebook Setup

Trough |pTrough v

Barriers Sensors  Sampling

Last calibrated | ---.- |

Last zeroed Tue, 27 Sep 14:28 Zero
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Calibration with a known weight

e Sensor Calibration - O X

Reference

Calibration type: ® Weight (O Surface Tension

Weight [100 | mg (728
Samples

Minimum [20 | Maximum [ 300

Window size | 100 | Tolerance | 0.1 | mV

Select medium

(O Empty weighing pan

(® Pan with reference weight

Ensure the correct weight is in the weight pan,

Results
Average (mV)
0.7

Std.Dev. (mV)
0.02 20

Samples
Tare
Weight

Exit

Notes

»|

@ In the Samples section you can

set the criteria required for sufficiently
good data, in the example shown at
least 20 samples is taken, and then
continued until the set tolerance is
reached. Once 100 samples have been
recorded the last 100 samples will be
analyzed, and when 300 samples have
been reached sampling will stop
independently of the tolerance.

Q The » symbol on the right border
opens up a panel with calibration
instructions.

@ We recommend a weight around
10 mg, since this is near the force range
used in the measurements. You can buy
a reference weight or for example cut a
small piece of wire and weigh it on a
high precision laboratory scale.

If you have lost the calibration hook
provided with the instrument, you can
conveniently make one by making a
hook from an old probe.

Select Calibration type: Weight, and enter the magnitude of weight you are
using.

Select the medium empty weighing pan and place the weighing hook on the
sensor. If you rather measure with the reference weight first, then add the
reference weight to the hook.

Push Start. Once the sampling has been done the medium will be shifted to
the other (If you record several times, the medium is not automatically
switched).

Add (remove) the reference weight and push Start.

Once finished push Save & Exit. You can also redo a medium if you are not
satisfied with the results.

Calibration with a reference weight does not provide a zero point for the surface
tension scale - proceed to Zero on the Sensor tab to do this step.

Calibration with liquid

11



Notes

Noon Sensor Calibration — O X

Reference

Calibration type: (O Weight (@) Surface Tension

(118 | w0 sufaceTension [728 | mi/m
Samples
Minimum [20 | Maximum | 300
Window size | 100 | Tolerance | 0.1 | mV

Select medium

(O Probe in air

Start

(®) Probe in interface

»|

Click 'Save Exit' to finish

Results

Air

Interface

Average (mV) Std.Dev. (mV) Samples
-1058. 0.10 39
-269.6 0.07 20

Sensor Zero

Dosensorzero () Pressure (@) Surface tension

Select Calibration type: Surface tension. The default surface tension value
is 72.8 mN/m (20 °C), but should be corrected according to temperature.
At 25 °C the surface tension has dropped to 71.99 mN/m.

Place the probe on the sensor and select ‘Probe in air’. If you rather measure
with the probe in the interface first lower the probe to the interface. Please
notice that for the Wilhelmy plate we recommend to always start by
recording the air reference value, since it takes several minutes for the
Wilhelmy plate to dry in ambient air. See the information box below for
instructions on how to immerse the probe.

Push Start. Once the sampling has been done the medium will be shifted to
the other (If you record several times, the medium is not automatically
switched).

Immerse (pull out) the probe and push Start. Please see the information
box below how to properly immerse the probe.

Before pushing Save & Exit, you can choose to use the calibration data for
taring the sensor. You can also redo a medium if you are not satisfied with
the results.

12



Notes

@ When the probe is lowered to the interface, we recommend the following procedure
to ensure a negligibly small contact angle, while keeping the buoyancy error small. First
flame-clean the probe and let it cool for a minute.

Then lower the probe until the tip touches the surface. This is the ideal level for
measurements as at this level the buoyancy is zero. Then continue to lower the probe by
ca. 1 mm and bring it back up by exactly the same amount, so that the tip of the probe
is at the “ideal” level. These steps ensure a receding contact angle, which tends to be
negligibly small. For a clean and freshly flamed probe the contact angle is very small,
however, if the probe surface is compromised the recedina contact anale is less sensitive.

Zeroing / Taring

Taring may be necessary for setting a correct force reference level, for example
at the beginning of an experiment, or if you change the immersion depth of the
probe. The latter affects the buoyancy term of the measured force. There are two
ways to tare the force sensor. You can do it either by holding down the ‘Zero’
button on the common controls and status panel (see *‘Menus and Windows’
section for details), or by opening the ‘Zero dialog’ window on the ‘Setup’ ->
‘Sensors’ tab. The former simply averages the readings taken while the button is
pressed, whereas the latter provides a more rigorous approach where a tolerance
is set for a given Window of samples.

Please check calibration mode and probe position before starting

Surface Pressure

Perform zero pressure calibration

Mode
(O Tension (probe in air)

(® Pressure (probe in sample)

Reference Surface Tension | 72.8 mN/m

Voltage (mv) Average (mV)  Std.Dev.(mV) Samples

<

common centrols and status

Start Pause Zero Ri
T h
o Surface Potential »
006 [[] Perform zero potential calibration
1L et At e . T
£ 002
—
Fd
E
P 000 -
2 Samples
Q
r -0.02 I m I
o Minimum | 20 ] Maximum 3DD|
004 Window size ‘ 50 Tolerance { 0.1 mV
-0.06
-0.06 -0.04
Start Save 8¢ Exit Exit
00 ++ @

Fig. Left Zero button, which averages the values collected while pressed, and Right
Zero dialog window.

13




Notes

To tare the force sensor select ‘Perform zero pressure calibration’. Select Tension
or Pressure depending on if you measure with the probe in air of in the subphase.
Then set the reference tension, i.e. the surface tension of the subphase without
surface film. This value is used for relating the surface pressure to the surface
tension through,

T=Yo—Y

Where = is the surface pressure and yo is the surface tension of the pure subphase.
If you measure with the tip of the probe at the water level, and have the correct
reference tension the result should ideally be the same for both Tension and
Pressure zeroing. Set the statistical criteria for the taring (as in the calibration
dialog). Push ‘Start’, and when the taring is finished push ‘Save’. Please note that
if you do not know the correct reference tension, either the surface tension or
pressure scale is offset depending on choice. Many times it is sufficient to work with
one scale correctly tared.

You can also select ‘Perform zero potential calibration’ to tare the surface potential
scale. If you have chosen both surface potential and pressure, the calibration will
proceed until both sensors satisfy the calibration criteria. If you need to use
separate parameters for the acceptance criteria, you need to do the calibrations
separately.

The software is now setup and ready for an experiment.

Chapter 3. Measurement methods

Tensiometer mode

Measurement  Notebook Setup

mode | jv
Measurement settings

Currenty | 105.80 mN/m

Idle

‘Tensiometer mode’ provides a simple interface to measure surface tension or the
current reading of all connected sensors. The method does not provide a means
to manipulate the positions of the barriers. For surface tension measurements,
the force sensor should be tared with the probe in the air, and the surface tension
measured with tip of the probe level with the subphase surface. To find the
correct height, slowly lower the probe until it contacts the surface. Then, to
ensure a negligible contact angle, immerse it around 1 mm further and pull it
back by exactly the same amount. Push the ‘Start’ button to begin measuring.

<

common controls and status

Measurement Buffer:

Run time: Clear | 07 3000000 | Save to File

Start ause Zero

Traunh

14



Notes

Compression isotherm

The compression isotherm method provides an interface to setup a compression
isotherm, where the barriers are moved at constant Speed (you can switch to
rate defined in terms of area per molecule by clicking on the unit). When the
surface pressure exceeds the target pressure, Target n, the measurement is
stopped. You can also set a Start Delay to postpone the beginning of the
experiment, for example if you want to equilibrate the film.

Messurement  Notebook = Setup

mode G ion isotherm |
Measurement settings
Currentm [-33.00 | mN/m
Targetn [ 10.00 mN/m
Speed [ 10.02 mm/min
Start Delay min

[J Pause measurement when target reached

Idle

Constant area

Measurement  Notebook ~Setup

mode Constantarea | v

Measurement settings
Current Area | 12153 mm*
Target Area | 50000 mm*
Maxhres [12154 | mm?®
Speed [ 14025 | mm/min
StatDelay [ | min

[J Pause measurement when target reached

Idle

The constant area measurement compresses or relaxes the film at a given speed
until the desired area has been reached. Once the target area has been reached
the barriers and recording are stopped.

Constant pressure

15



Notes

Measurement  Notebook Setup
Measurement mode |Constant pressure | v
Measurement settings
Currentm [-33.00 | mN/m
Targetm | 10.00 mN/m
Speed | 10.02 mm/min

Start Delay min

Idle

The constant pressure mode compresses/relaxes the film to a desired surface
pressure n. Once reached, the pressure is maintained at the target until the
experiment is stopped. There is a tendency for the pressure to oscillate around
the target. This can be reduced by using lower speed. This method is useful for
equilibrating the monolayer at a desired pressure, or to keep the pressure
constant while depositing the monolayer film on a substrate.

Manual

In the manual mode the barriers can be manually controlled and data recorded.
To start data recording push the Start button in the common controls and status
panel. The barrier operations are independent and do not start data recording in
this mode.

Measurement  Notebook ~Setup

Measurement mode Manual v
Measurement settings

Speed [70.02 | mm/min

Idle

Manual Mode controls

= Relc

[ I'stopped | |

Hysteresis mode (pressure hysteresis mode)

Measurement  Notebook Setup

mode Hysteresis 1w

Measurement settings
Current [-3300 | mN/m
MaxTargetw [7280 | mN/m
MinTargetw [100 | mN/m
Speed [1002 | mm/min
Start Delay min
Loop [1

[JPause measurement when target reached

Idle

16



Notes

The pressure hysteresis mode cycles between minimum and a maximum pressure
target pressures. Please make sure that the target pressures corresponds to
areas which can be reached by the barrier drive. If the barrier drive reaches
either end the measurment will stop.

Min Target = and Max Target = set the low and high pressure vertex for the
measurment. Loop sets number of times the pressure is cycled between the
minimum and maximum target pressures n.

Area hysteresis mode

Measurement Notebook Setup

Measurernent mode | Area Hysteresis W

Measurement settings
Current Area | 28000 mm?
Speed | 10.02 ram/min
Mazx Target Area | 20000 mm’
Min Target Area | 10000 mm’

Start Delay min

LA

Loop |1

[[]Pause measurement when target reached

| Idle

Apply Cancel

In the area hysteresis mode the barriers are looping between the Min Target Area
and Max Target Area. Loop is the number of loops made between the verteces.
Please notice that due to the discrete nature of the stepper motor the verteces may
be exceeded by up to 75 mm? (i.e. 1 mm) at maximum speed. Please set the
parameters with sufficient margin to the maximum and minimum range of the
barrier drive. Overriding either end will cause the measurement to stop.

Chapter 4. Menus and Windows in Filmware 4.2

17
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Main screen

S FilmWareX -
File View Tools Addons Help

=i}
X

Thu, 29 Sep 2016 01:57PM Load Measurement it
Idle

Surface Tension 38 7 mN/m
Surface Potential -2500.5 mV
Area 12153 mm?

Temperature 25 °c

common controls and status
Measurement Buffer:

Measurement  Notebook ~Setup Start Zero Run time: Clear 07 2000000 Save to File

mode G isotherm v

Trough
Measurement settings

Currentm | 3413 mN/m 006

—— Trough : Pressure (mN/m)
Targetm [ 10.00 mN/m

Speed | 10.02 mm/min
Start Delay min

[J Pause measurement when target reached

Pressure (mN/m)
o
S
8

Idle

-0.06 -0.04 -0.02 0.00 002 004 006
Area (mm?)

1:57 PM
9/29/2016

~ tm [Z ENG

Fig. Layout of the main screen of Filmware 4.2.

Status, current sensor readings and barrier position (area) are shown in the top
left panel. The first reading is the input from the force sensor. You can toggle
between surface tension, surface pressure and output potential by clicking on the
reading.

The second reading is the surface potential signal from the Microspot accessory
connected to the SENSOR 2 inlet. If you do not have the Microspot accessory the
reading corresponds to the resting potential of the analog to digital converter.
You can also connect your own analog devices (please contact Kibron for details
on the connection).

The third reading is the area between the barriers. You must make sure that you
have initialized the instrument to get the datum position set, and that you have
selected the correct trough.

The fourth reading is the temperature from the sensor connected to INPUT 1.

Tabs for selecting measurement method, defining and recording experimental
parameters (Notebook), and setup of the instrument are located below the
status panel.

Notebook tab

The notebook tab contains key experimental parameters describing an
experiment. These are saved with the measured data. When an experiment is
loaded (see Loading experiments below) the Notebook entries are shown with the
loaded experiment. It is good practice to enter data which describe an experiment
sufficiently and links it to entries in an ordinary laboratory notebook.

The data cannot be edited in FilmWareX after the measurement data has been
cleared. If you need to edit, you can do it in a standard text editor, for example

18
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MS Notepad. Notice that if you alter structure of the of the data, Filmware may
fail to open the file.

Measurement Notebook Setup

Define Film
Film

Controls for the notebook

Title | Demo Notebook

Date [1/13/2017 CRate [016 | A¥/acyl

chain/min

Temp (9990 | °C Barriers [
Lipids | DPPC, chol | Troush [G2
Data C. Isotherm ‘ Subphase |20
measured
User defined ‘ Author [User

parameters

Notes

One of the central concepts in the notebook is the film or monolayer studied.
Langmuir films have a strong tradition in the study of lipids and fatty acids,
therefore we use the term "“Lipid”. It is equivalent to "Component”. The FilmWare
supports film of up to 4 components in the same film. Choose Edit lipids to enter
new compounds in the compound library and select to add compounds to the
studied film. If you set the number of chains equal to one, area / chain equals the
area / molecule. It is not mandatory to define the film prior to an experiment,
however, some parameters like area / chain and rate [&/ chain min] are not
defined. Avoid using space ( ) in the chemical name or abbreviations. This can
lead to errors when loading previously saved data using space as a field
separator.

},-m Define Film XK |

Select compounds

- Edit Lipids Select [
| Select Compounds X
Compound data Lipids: Selected Lipids:
Compound w DMPC
PPDPC
R DMPG Add ->
Mole fraction l \ hal
DPPC
Concentration mg/ml <-Remove
Volume applied \ ‘ ul
Amount of compound |:| nmol
Total amount ‘ } nmaol
Stoichiometry
Moo Lipids — O X
| ; Id Abbr.. Chemical name Mole... Chains
.| T 1 1 DMPC  dimyristoylphosphatidylcholine 674.00 2
l_ | ! | 2 ppDPC 1-palm-2-pyrdecan-PC 850.00 2
) 3 DMPG  Testing lipids 670.00 2
| ' 4 chol  cholesterol 35000 1
| 5 5 DPPC  Dipalmitoylphesphatidylcholine 734,10 2
Euit Delelefow Bit

19
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Display and loading measurement data

Trough Old sensor

— Old sensor : Pressure (mN/m)

Pressure (mN/m)

i H
100 200 300 400 500 600 700
Time (secs)

The graph for plotting ongoing and previously recorded data is found on the lower
right side. The buttons below the graph are self-explanatory. The save button
opens a dialogue to save the graph as a picture - notice that it does not save the
measurement data! The legend can be toggled on/off by left clicking = and
rotated between all four corners by right clicking -=.

%,_;Trough - Plot Setup — O X
Y2
Area (mm?) v
Autoscale M
Min: | 0.0 Max | 121540 | Apply |
= .. — ‘

Double clicking the graph opens a dialog for setting axis data and ranges. You can
also open the Plot Setup dialog from the View menu on the top.

Load Measurement New sensor -filter 5

Load
File Title Date Sz
N -filter S.ntb 9/15/2016 4:09:54 PM 34
— ,
£ Plot 2
Plot On >
common controls and status

Load Measurement New sensor -filter 5

Wil

kde I C\Users\User\New sensor 'ﬁ“# C:\Users\User\New sensor -filter 5.ntb ] Properties

Title I Key Value

=-Properties
Date | 9/15/2016 4:00:54 P CRate (000 | AYacyl L@ ,ﬂotebmk

chain/min
v
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Trough DPPC- G2
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On the top right side you find a dialog to load and plot previous experiments. The
Load button opens a file dialogues. Once loaded the data can be plotted by right
clicking on the experiment. Plot opens a new tab in the graph, while Plot on
allows you to select the tab to plot on (Overlays). Each opened Notebook file
creates a new tab in the panel. These tabs contain experimental and notebook
data corresponding to the experiment.

Control buttons for the experiment

<

comman controls and status

Measurement Buffer:
0/ 2000000 |

Start Zero Run time: I Clear |

Tranah

Between the two right hand panels you find a set of controls for your
measurements. Clicking the Start button begins measuring with the selected
method and parameters. The button automatically changes to Stop when the
measurement is running. Pause / Continue pauses and continues the current
experiment. Zero is a quick button to zero the surface pressure. It averages
samples while the button is pressed. There is another Zero method, found on
the Setup tab, which more rigorously collects data until a given tolerance has
been achieved.

The Run time box shows the time elapsed from the beginning of an experiment.
The Clear button empties measurement data buffer. The Measurement Buffer
box shows the number of samples recorded and the maximum number of
samples that can be recorded. We have set the buffer rather large (138 h at 0.25
s sample rate) and it should be sufficient for all imaginary experiments, but if you
need more even more samples in your measurement, you can increase the buffer
size as described in the Specials section. The Save to file button opens a dialog
for saving your data, i.e. measurement buffer and notebook information in so
called notebook files (.ntb).

Troubleshooting

Filmware does not start up
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Notes

The most common problem in starting FilmWare occurs after the electronics unit
has been shut down or disconnected before the software has been closed. This
may lead to a situation where FilmWare cannot start or take control over the
previous communication process, which is still running. If the FIlmware does not
start open the Task Manger (Shift + Ctrl +Del). End the Kibron communication
component process (KbnMTIO~.exe). Then end the FilmWareX 4.2 app.

i~ Task Manager — O X
File Options View

Processes Performance App history Startup Users Details Services

~ 7% 53% 88
Name CPU Memory B
| =] IITCENR) CoCdl |V|dlldge]"r'!ellL SEVICE (32 01 U0 U T IVIE L A I
[ Intel(R) ME Service (32 bit) 0% 0.2 MB C
Java Update Scheduler (32 bit) 0% 0.1 MB £
@- Kibron communication component for UTrough (32 bit) 0.2% 0.9 MB C
Lenovo Energy Manager 0% 1.3 MB C
@ Lenovo Motion Control 0% 5.4 MB C
[E Lenovo Utility 0% 0.4 MB C
[ Lenovo Yoga Mode Control 0% 9.0 MB C
@ Lenovo Yoga Phone Companion 0% 0.3 MB C
[E LsvController (32 bit) 0% 2.0 MB L
LsvTrayload (32 bit) 0% 1.8 MB ¢
[ LsvUIService 0% 1.3 MB C
[8 Machine Debug Manager (32 bit) 0% 0.9 MB C
B Microsoft Edge 0% 42 MB C
[ T e — —— il
< >
Fewer details End task

Filmware runs but the communication is interupted

Some virus protection softwares with behavioral analysis modules may interpret
the Kibron Communication component (KbnMTIO~.exe) as malicious. If this
occurs the FilmWare directory needs to be safe listed in the virus protection
software.

Separator in Notebook (.ntb) files

You can choose the separator used in the Notebook (.ntb) files from the Tools=>
Notebook format... Notice that if you use space as a separator, loading of saved
files fail if the chemical name or abbreviation contains space(s). It is good
practice to use underscore ( _ ) instead of space. The default separator is
semicolon (;). The .ntb files are ascii based and can be read into most
spreadsheet or text editors.

Other bugs and crashes
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Notes

Please report crashes and bugs to Kibron along with a copy of FWX_40.log. This
log contains information on the command sequence and responses from the last
session.

Setting the Measurement Buffer size

If you need to set the measurement buffer size for very long measurements,
open a command prompt window, go to the FilmWare directory. Then start the
FilmWare with the command:

FilmWareX 40.exe -b <buffer-size>

The buffer setting is only valid for the started session, i.e. if you start FilmWare
from the windows menu or desktop the original buffer size of 2 000 000 is
restored.
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